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Now that Sound Designer II no longer provides sampl er support, the way is clear for an improved
version of the veteran Alchemy software. MIKE COLLI NS thinks it's worth its weight in gold.

 

Alchemy sample-editing software for the Macintosh has been around for some years now, but after disappearing briefly (as if
to gauge its popularity) it's had a facelift and staged a comeback. At least part of the reason for this new lease of life is
Digidesign's decision to remove sampler support from its Sound Designer II software. Sound Designer II started out as a
sample editor, and allowed you to transfer audio to and from a range of popular samplers, but has now been optimised for
editing complete audio recordings rather than short audio samples. This has opened up a niche for Alchemy 3.0, which has
been upgraded to support the most popular samplers currently available. I'll run through the new features first, before
recapping on the basic package, and offering a few tips and hints on how to get the best from it.

NEW FEATURES

Existing Alchemy users will be pleased to hear about the many useful new features: the Soundfile Info dialogue has been
expanded to include a pop-up menu which lets you access all open files, a new Graphical Key remapping function, and loop
start/stop information. The Graphic Keymapping provides a quick and easy way to assign pitch ranges to samples using the
mouse, while the Loop Information allows you to numerically adjust loop start and end points, or turn loops on or off.

The Process menu also has some additions. For instance, the Pitchshift Dialogue now shows frequency in Hertz and cents, to
allow finer adjustments than previously, and the Resample dialogue now features an option to set sample rate conversion
based on the period of the sample (ie. how often the waveform repeats itself). If you click the button labelled 'Sample Period',
the sample rate is recalculated to an integer multiple of the sample period, which makes looping much easier. Once you've set
your loops, you can change the sample rate to suit the particular sampler you are working with -- and that includes any
changes you've made.

Talking of looping, Alchemy 3.0 now lets you adjust loop points in the waveform window using the left/right arrow keys on your
Macintosh keyboard. Using the modifier keys (Command, Shift and Option) you can edit either the left or right loop points, or
move both loop points together. These great features allow you to loop your samples much more quickly, accurately and
efficiently before transferring them to your favourite sampler, with the benefit of seeing much more on your Macintosh screen
than in any sampler currently available -- including the Roland models, which let you attach a video screen for editing.

Several new commands appear in the Edit menu for selecting harmonics in the Harmonic Spectrum window (the window which
appears when you analyse a soundfile). Using these commands, you can select particular harmonic ranges of a sample to cut
or shift up or down -- and you can achieve some very useful effects using these features. So, for instance, to create short echo
effects, you can select every fourth harmonic and cut these, then select every third harmonic and replace these with the
previously-cut fourth harmonics. This will shift portions of the harmonic spectrum down by an increasing factor, and the shift in
the higher frequencies will result in that portion of the sound content playing back more slowly -- resulting in the simulated
echo effect. Another helpful command is 'Select Less Than', which can be used for selecting all the lower-amplitude harmonics
and then clearing them. This will sometimes clean up a sample, resulting in greater clarity.

 

"You can build up a library of useful envelopes -- stored as waveforms with
the appropriate envelopes -- for future sound-desig ning projects."

 

Alchemy 3.0 can now open mono and stereo Sound Designer II, SoundEdit and stereo AIFF files -- which means that you can
open just about any type of audio file you are likely to come across on your Mac. Alchemy 3.0 can also read and write 8- and
16-bit WAV files, which are commonly used on PC systems. Files translated with Apple File Exchange, PC Exchange, or similar
programs can be opened in Alchemy 3.0 if they have the filetype 'WAVE' or the .WAV file extension, and 8-bit files are
converted to 16-bit when they are opened. The Save As dialogue then allows you to save files in either 8- or 16-bit WAV
format. You can set the file type of any file on your Macintosh (using Apple's ResEdit and other popular utilities) so that they
will be recognised by the appropriate software.

Support has been added for the Digidesign Pro Tools I and Pro Tools III boards, along with the older Sound Accelerator II and
AudioMedia II boards. Alchemy 3.0 also supports the RasterOps MediaTime board favoured by some multimedia producers,
and using the Apple Sound Chip available in most Macs, you can now play stereo samples without using any third-party
boards. And Alchemy 3.0 now supports version 3.0 of the Apple Sound Manager, which means that PowerMacs, AV Quadras,
and add-on hardware that supports Sound Manager 3.0 can play back 16-bit audio directly. The Listen button in the Open
Special dialogue will also play loops in looped samples. Finally, support has also been added for Opcode's OMS and for
MTP-compatible multi-port MIDI interfaces.

Sound files can now be recorded directly into Alchemy 3.0 using the Apple Sound Manager v3.0, so there is a new 'Record
Sound' item in Alchemy 3.0's Action menu. Sounds are recorded into free RAM (the amount of free memory available to
Alchemy 3.0 is always displayed in the Tool Palette). Don't worry if you run out of RAM for recording; Alchemy 3.0 will stop the
recording process for you, although you might get a little frustrated unless you have mega amounts available!

When you choose 'Record Sound', a dialogue will appear where you can make the appropriate settings. Here, you can choose
between the input device (which could be the Mac's built-in digitiser, or a Digidesign or RasterOps board), set the sample rate
and resolution, choose mono or stereo, and monitor through -- if required. With everything set, you use the Record, Stop and
Play controls until you're satisfied with the result, and then hit Done. The newly recorded sound file will appear in an untitled
window in Alchemy 3.0, and to save this you just use the standard Save As dialogue and select a file format. A good tip here is
to make a test recording and then check this in Alchemy 3.0's waveform window, to see if the loudest portions are clipping, or
if the levels are too low, before making your final recording.

MAIN FEATURES

Once you have some sound files to play with, you can use the Waveform Drawing mode to redraw a waveform, which can help
to eliminate pops or other glitches. This is a useful tool at times, although in practice, it can be very difficult to correct such
flaws.

If you are preparing material for your sampler, you will probably want to loop the sound next. The looping tools are pretty
comprehensive, and there is an excellent section in the manual which describes how to make simple splices, crossfade loops
and mirror loops, with plenty of tips on achieving perfect-sounding loop points. There are also various simple tools available to
let you reverse a sound, invert the waveform, fade in or out, sample rate-convert and so forth. You can also apply digital EQ to
any waveform, choosing from low shelf, high shelf and peak/notch type EQ filters, and set parameters for centre frequency, cut
or boost, and width in the case of the peak/notch type. The EQ features are not quite as comprehensive as those in Sound
Designer II, which also offers graphic EQ (and dynamics processing), but they are adequate for basic EQ'ing tasks.

The most basic edits you might make will involve Cut, Copy and Paste operations, and you can choose to use the Blending
functions here if you like. Blending is an auto-crossfade function which is carried out every time you use the Cut, Paste or
Insert commands. When you perform one of these edits with the Blend function on, all edit splice points are automatically
crossfaded with each other to produce a smooth splice transition. The size and slope of the automatic crossfade range used at
each splice point is set using the Edit Options command in the Edit Menu. Using the Blend function ensures that your edits will



each splice point is set using the Edit Options command in the Edit Menu. Using the Blend function ensures that your edits will
not cause a click, pop, or 'brick wall' transition at splice points.

The Blend function actually accomplishes its task by overlapping the waveforms before and after an edit splice point,
according to the size of the Blend Amount. Since wave data is being overlapped, the overall duration of the sound will be
generally decreased -- so you do need to keep this in mind when using this function. There is now a handy button just above
the numeric display at the bottom of the Tools palette, which lets you turn Alchemy 3.0's Blending feature on and off, rather
than using the Edit menu item. There is also a numerical display to the right of this, which shows the current blend time in
seconds; a mouse click on this time field will open the Edit Options dialogue, where you can change the Blend time amount.

TEMPORAL DISPLACEMENT ZONE

In common with Sound Designer II, Alchemy 3.0 lets you do both time-stretching and pitch-shifting. Sound Designer II offers
more control and can sometimes achieve better results while time stretching, but on the other hand, Alchemy 3.0 will detect
the pitch of the sample for you -- while in Sound Designer, you have to compare the sample pitch with an A440 tone, and set
the pitch manually.

Pitch-shifting allows you to change the pitch of a sampled sound accurately, with or without changing its duration. To shift the
pitch, you select a range (or the entire sound) and choose Pitch Shift from the Process menu. You get a dialogue box, with a
music keyboard, where a dark grey key indicates the selected sound's current pitch. Just click on any key to choose the new
pitch, or type a transpose amount into the 'Transpose by' box. If you want the pitch-shifted sound's duration to match the
original duration, you can select the Preserve Duration option. When you have made the settings you want, just click OK to
execute the pitch-shift. Using this feature, you can quickly create harmonised sounds by first pitch-shifting your original sample
(such as a guitar note) down by the interval you want, copying this to the clipboard, undoing the pitch-shift on the original
sample, then using the Mix command in the Edit menu to mix the pitch-shifted sample with the original sample to create your
desired harmony.

Time Scaling is the process of changing the duration of a sampled sound without altering its pitch. To apply this, select the
range to be scaled, or select the entire soundfile, and choose Time Scale from the Process menu. Type in a new end time for
the range, or type in a scale factor describing the relationship between the scaled file and the original file. Then hit Calculate.
The Duration value is automatically updated to how long the processed file will be. When you are happy with this, click OK to
apply the process. Scale factors between 0.7 and 1.3 are suggested for best results, as more extreme values will alter the
sound too much. A 'Grain Size' field has been added to the Time Scale dialogue to help you get more flexible results. A Grain
size with the default value of 30 has always been used for time scale operations in Alchemy 3.0, but prior to version 3.0, the
Grain size was inaccessible to the end user. It is now possible to decrease the Grain size to as small a value as '2' or as great
a value as the sample rate, size, and time scale factor will allow.

 

"Alchemy 3.0 is an indispensable tool for anyone in volved in sampling who
has a Mac."

 

The Grain size is an arbitrary unit used to define a 'time slice'. During a time-scale operation, time slices are analysed for
frequency and amplitude content, and a new time duration is constructed, one slice at a time. Smaller Grain sizes can result in
a 'smoother' end result, but there are trade-offs. To start with, smaller Grain sizes will require more time for computation. Also,
when using smaller Grain sizes, the low-frequency content may not be properly analysed. The lower the frequency, the more
samples are required to determine the frequency, so if you use too small a Grain size, the low-frequency content in your
sample may be lost entirely. Using a larger Grain size produces sounds that might best be described as 'more chunky'. The
end result can sound similar to an echo effect, as longer 'time slices' of the sample are reproduced. Another nice bonus is that
time scale operations are faster with larger Grain sizes.

As with other DSP effects, the best way to understand and learn what does and doesn't work is to experiment. Rather than
limiting the use of this feature (by limiting the range), the field will accept any value from 2 on up, and only warn you if the
Grain size or time scale amount is unusable. The Grain size cannot be 'larger' than the duration selected, for instance. As to
what a 'Grain' actually is, well, technically speaking it's a 111000th of the sample rate, plus a 'taper' factor. The taper amount
ensures that the size result is an even multiple, and is also used to blend the time slices together. Again, don't try to analyse
this one too much -- just fool around and see what works.

ADVANCED FEATURES

So far, the features we have looked at are similar to those available in Digidesign's Sound Designer II software, but Alchemy
3.0 goes quite a bit further, with specialised features for sound design.

As in Sound Designer II, Alchemy 3.0 offers a spectrum analysis feature. Sound Designer offers more display options than
Alchemy 3.0 -- but Alchemy 3.0 lets you not only display, but also edit the harmonics, which is a much more powerful feature.
Alchemy 3.0's harmonic spectrum display shows a series of vertical lines representing the individual harmonic components of
the waveform you have selected to analyse. The height of each line represents its amplitude, while its horizontal position
represents its frequency. Just select the part of the waveform you're interested in, and hit the 'Analyse' button in the Tools
palette. This brings up the harmonic spectrum display, where you can select any harmonic using the mouse, get a readout of
its frequency and amplitude in the numeric display at the bottom of the Tools palette, and drag it up or down to change its
amplitude.

If you want to select all the harmonics above or below this, there are menu selections in the Edit menu. These commands
mean that you can use the harmonic spectrum display effectively as a very accurate low-pass or high-pass filter, to remove all
frequencies above or below a particular frequency. To hear your results, click on the waveform display, and then on the
Resynthesize icon (the palette tool which looks like a sine wave). Another use of this feature is to take out (or reduce in
amplitude) any unwanted harmonics -- a hum, or any other annoying frequency component, for example.

Unfortunately, there is a limit (32,768 samples) to the length of the audio waveform you can analyse, and you can only edit one
channel at a time within a stereo file. These are serious limitations, which restrict the use of this feature to relatively short
samples, and make it less convenient for working with stereo files. Of course, as with Sound Designer II, you could always use
the spectrum display to look at the harmonic content of a small, hopefully representative, portion of your waveform, and
thereby identify problems such as unwanted frequency components, or too much energy in any part of the frequency
spectrum, and then apply EQ filters to correct the problem.

Another useful feature is the 'Replicate' tool, which lets you copy a range of your waveform and repeat this over a large
waveform area. This tool functions by taking whatever waveform you have copied to the Mac's clipboard, and duplicating it
repeatedly until it fills the new range you've specified. For instance, if you want to repeat a sound or a portion of a sound to get
a stuttering effect, and your soundfile only contains the sound you want to repeat and nothing more, you will need to extend
the Sample Size (that is, the length of the soundfile), to make space for the repeats you want.

If you want to do this precisely, you need to know the exact length of your original soundfile -- which you can find by selecting
the whole file, and checking out the Soundfile Setup command in the File menu. This brings up a dialogue box, which shows
the Sample Size as a number. You need to multiply this by the number of repeats you require, and then type the new number
in the Sample Size box. Now when you look at your waveform, the display is much longer, but the new part is empty. To make
your repeats, select the original waveform and copy it to the clipboard. Next, select the entire waveform, including the blank
portion, before hitting the Replicate button in the Tools palette (the icon for this looks like two matchstick men standing side by
side). Now you will have the exact number of repeats you want, exactly filling the length of your soundfile. This does seem a
little 'fiddly' at first, and the instructions in the manual are a little vague at times, but once you've got the hang of it, this is a
useful tool.

WELL SYNTHESIZED



WELL SYNTHESIZED

The next pair of features, the Amplitude and Frequency Enveloping modes, take us well into the realms of sound synthesis,
offering the opportunity to apply volume and pitch envelopes to your sounds.

The Amplitude Enveloping mode allows you to adjust or trace the amplitude envelope of any sampled sound. Traced
envelopes can be copied and superimposed over other sampled sounds, so, for instance, you could trace the envelope of a
violin, and superimpose that envelope over a piano to alter the way its volume changes over time.

 

"These great features allow you to loop your sample s much more quickly,
accurately and efficiently before transferring them  to your favourite
sampler."

 

This feature is pretty easy to use. With a soundfile open, when you click on the Amplitude Envelope mode icon, the waveform
will be greyed out, and a horizontal amplitude envelope line will appear near the top of the Y-axis. This default position
indicates that the amplitude is at its maximum value for the duration of the sample. If you click on this line, you will create 'break
points' wherever you click, and you can set any number of these. You then drag these breakpoints around to set the particular
amplitude levels you want over time within your soundfile. Once you are happy with the shape of the envelope you have
drawn, choose the Amplitude Fit tool to increase or decrease the amplitude values in your soundfile to fit exactly under the new
envelope. Alternatively, you can use the Amplitude Scale tool to adjust your waveform to the correct shape, although not
necessarily to the same actual amplitudes (this option is provided because, in practice, Amplitude Scale works better on low
amplitude sounds, or those that contain areas of silence).

Have you ever wanted to make a sample decay over time exactly as another sample does? For instance, imagine a sample of
a guitar pluck which dies away fairly quickly, so that its amplitude envelope is like a sloping line starting high and falling off to
zero quite quickly. You decide that you like the way this sample decays, but you want to use a different guitar sound. The other
guitar sound you want decays in a different way, so you need to force its decay envelope to match that of your original sample.
Easy -- just open the sample file with the desired envelope, switch to Amplitude Envelope mode by choosing the ADSR-like
icon from the Tools palette, and then choose Trace Envelope from the Process menu. This draws an outline of the decaying
envelope of your plucked sound. Copy this to the clipboard using the Copy Envelope command in the Edit menu. Next, open
the guitar note sample you want to use, switch to Amplitude Envelope mode, and choose Paste Envelope from the Edit menu.
The amplitude envelope you originally traced and copied from the sample you liked is now pasted into the new guitar sample's
amplitude window.

At this point, it is recommended that you use the Scale feature to scale the amplitude envelope to the maximum amplitude
value, to make sure that the resulting waveform will make use of the full amplitude scale. Finally, click on the Amplitude Fit
icon. This fits the plucked envelope which you want over the more sustained envelope of your new sample.

When I tried this the first time, I got a little confused -- until I realised that I was applying the envelope from a three-second file
to a six-second guitar note. The general shape of the envelope was still the same, but the six-second soundfile still took six
seconds to decay, while I had somehow expected it to just last three seconds -- like the envelope. To make this work properly, I
had to edit the six-second guitar note to last just three seconds, so that the new note sounded just like the original
fast-decaying plucked guitar note.

BACK OF AN ENVELOPE MODS

In a similar way to that described above, Alchemy 3.0's Frequency Enveloping mode makes it possible to modulate the
frequency of any sampled sound by drawing in a modulation envelope, or by pasting in any waveform to act as a modulation
envelope. When you click on the Frequency Enveloping mode icon (which looks like a sawtooth wave) in the Tools palette,
your waveform greys out and a horizontal amplitude envelope line running along the X axis is shown, indicating that no
modulation is being applied. You can click on this line to insert break points, or just use the default break points at the start and
end of the sound, if you just want to make the pitch rise or fall from one value to another throughout the sound. You can select
a frequency range of one semitone, one octave, or two octaves to define how far the pitch will be modulated when you drag
the break points to their maximum plus or minus values in the display.

With everything set, choose Frequency Mod from the Process menu to apply the processing to the sound. The pitch of your
waveform will then be modulated or shifted, according to the modulation curve defined by the modulation envelope which you
have drawn. So, using the Frequency Enveloping mode, you can apply the envelope of one waveform to control the frequency
(pitch) of another waveform over time. An example here would be applying heavy pitch modulation to a guitar sound, by using
a sinusoidal envelope to change the pitch of the guitar sample over time.

First, open the Loop Sine sample on the disk of example files which comes with Alchemy 3.0, and copy this to the clipboard.
Next, open the guitar sample you want to process, and select the Frequency Enveloping mode by clicking on the icon in the
Tools palette. You can choose a frequency range setting in the process menu, such as '1 Octave', and then use the Paste
Envelope command in the Edit menu to paste the sine wave into the Frequency Modulation window. You could use any
waveform you like here, but the sine wave makes the process clearer to understand when you hear it. To activate the pitch-
shifting, hit the Pitch Shift icon on the Tools palette. Now you will hear the guitar note being frequency-modulated up and
down, one octave above and below normal pitch, according to the Loop Sine envelope.

In practice, you can copy any envelope or waveform to the clipboard, and then use this as the amplitude or frequency
envelope for a different file. There is no actual difference between an envelope or a waveform when it is in the clipboard, so if
you think you have a useful envelope which you may want to use again, simply copy it to the clipboard, and save it into a new
file. You can build up a library of useful envelopes -- stored as waveforms with the appropriate envelopes -- for future sound
designing projects.

SUMMARY

All in all, Alchemy 3.0 is an indispensable tool for anyone involved in sampling who has a Macintosh computer. Yes, you will
almost certainly want to have Sound Designer II and a Digidesign board to work with, and you may well want a selection of
other tools such as Steinberg's Time Bandit for time-stretching and pitch-shifting, or the various plug-ins for the Digidesign
software which offer a wide range of signal processing functions. Nevertheless, when you are preparing sounds for use with a
sampler, Alchemy 3.0 has the extra features you will need to get the best results.

 

TAPPING OUT A TUNE

Alchemy has a great Multi-Tap Digital delay feature. The Echo item in the Process Menu brings up the Multi-Tap Digital delay
dialogue, which you can use to add simple or more complex echo effects. The upper portion of this dialogue displays one of
five identical panels, one for each of the five delay 'taps'. Using the Tap pop-up menu, you can select each panel in turn, and
make appropriate settings. The enabled taps have a black diamond next to them in the pop-up.

To enable additional taps up to a maximum of five, choose an unused tap from the pop-up and, when its panel appears, check
the enabled checkbox. Each tap can have its own delay time, initial delay, decay time, level and pan position, although the Pan
position is only available when you're processing a stereo soundfile, and both channels are selected. The initial delay is used
to set the time between the first occurrence of a sound and the first reflection (or first repeat) of the sound. The delay time is
the time between subsequent repeats. The decay time determines how long the delayed signal will repeat after the first
reflection occurs. 'Delay time' ranges from 1 to 3000 milliseconds, with 'Initial delay' from 1 to 3000 milliseconds, and 'Decay
time' from 0.0 to 30.0 seconds.



The relative amplitudes of the dry and wet signals can be adjusted in two ways: the Level control sets the level of the
processed signal for each tap, while the Mix control sets the overall mix of dry and wet signals. If you check the 'Echo within
selection only' checkbox, this will force the effect to be constrained to the selected region. Otherwise, the effect will extend
beyond the selected range, or if the entire soundfile is selected, lengthen the sample.

Alchemy comes with a few preset delay settings already provided, but you can also save an unlimited number of your own.
The presets include Stereo Bounce, Stereo Spread Simple Echo, Slapback, Reverbish, Pan Bounce and Roomverb. To
choose a preset, click and hold on the pop-up menu in the lower part of the dialogue and choose from the list. To create a new
preset, make your delay settings and click the New button. A dialogue appears that enables you to name your preset and add
it to the pop-up list. The Store button allows you to save changes to an edited preset, while the Delete button removes the
current preset from the pop-up menu. Altogether, this is a pretty serious feature, which offers the sound designer the
opportunity to experiment directly on-screen with various types of sophisticated multiple delay effects.

 

USING ALCHEMY WITH THE AKAI S1100 SAMPLER

You can transfer sounds to and from the Akai S1100 (or S1000) via SCSI or via MIDI. SCSI is much faster, so you should use
this in preference wherever possible.

First, select S1000/S1100 from the Network Menu, then choose Instrument: Edit from the Network Menu, to bring up a
dialogue box where you can select the correct SCSI ID for your Akai sampler. Mine is set to ID 6, for instance. You need to
check that your sampler is set to the same SCSI ID, of course, and you do this by hitting the MIDI button on the bottom row of
buttons on your Akai sampler. Then hit the F7 button on the sampler to bring up the SCSI page. Here, you will see 'S1100
SCSI ID : ?' with the number your sampler is currently set to in place of the question mark I have used. To get a sound from or
send a sound to the sampler, just use the appropriate commands from the Network Menu. You can also get or send all the
sounds or a range of sounds if you prefer.

If you have samples already in your S1100, you may want to transfer these to the Mac to take advantage of the more
sophisticated processing available in Alchemy, or any other Mac software you have, or maybe even just to do your looping in
the much larger waveform edit window on the Mac's screen. Alternatively, you may already have samples on your Mac, or you
may prefer to record them using Pro Tools to get the very best possible results, before transferring to the sampler. Once you
have sent your samples across, you will need to set up a program in the S1100, with suitable keygroups from which to play the
samples.

This is all very straightforward in practice, although I wish it was possible to set up the S1100 programs using Alchemy and
then send these back to the sampler with all the samples. Obviously it would be good to do this with all the samplers supported
by Alchemy, and this would involve plenty of programming effort. Nevertheless, it should be possible to add these features in a
modular way -- perhaps using some kind of software extensions to offer this feature for particular samplers.

 

pros & cons

ALCHEMY 3.0 £500

PROS
• Allows you to edit harmonics.
• Features a multi-tap delay.
• Offers amplitude and frequency enveloping features.

CONS
• Should offer support for a wider range of samplers.
• Could offer support for editing sampler programs.
• User interface could do with improvements.

SUMMARY
Alchemy is one of those packages which you will not use every day, unless you are constantly involved in preparing samples
for popular samplers. However, it contains software 'tools' to die for whenever you do want to edit your samples! Despite minor
criticisms, it is the best single package to buy for working with samples on the Macintosh computer.

 

info
£ £499.95 inc VAT.


